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Where to Find Information

This Startup Guide
Provides you with the basic information you need to start using 
your EPSON STYLUS PRO 7500 and its optional and consumable 
products.

Reference Guide included on the CD-ROM
Provides you with detailed information about printing on roll 
paper or cut sheet media, the control panel, the printer software, 
and tips that will help you get the results you want.

Opening the Reference Guide

Insert the printer software CD in the CD-ROM drive. Double-click 
Online Guide in Installer dialog box (Windows) or double-click 
Online Guide folder in the EPSON window, EPSON STYLUS 
PRO 7500 (Macintosh). The dialog box shown below appears.

Click View Reference Guide to open the guide.

To install the Reference Guide on your hard disk, click Install 
Reference Guide and follow the on-screen instructions.When 
installation is complete, the ESPR7500 (Windows) or a View 
Reference Guide (Mackintosh) icon appears in the EPSON 
folder. Double-click the icon to open the guide.
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Note:
If your hard disk does not have enough space to install the Reference 
Guide, view it directly from the CD.

Online Help
Provides you with detailed information and instructions on the 
printer software that controls your printer. (Online help will be 
automatically installed when you install the printer software.) See 
your Online Guide for information on accessing online help.

System Requirements

For using your printer with a PC
To use your printer, you need Microsoft® Windows® 95, 
Windows® 98, Windows® Me, Windows NT® 4.0, Windows® 

2000; and a shielded, twisted-pair parallel cable. If you want to 
connect your printer to a USB port, you need a Windows 98, Me, 
or 2000 pre-installed PC equipped with a USB port; and a shielded 
USB cable.

Your computer dealer can help you update your system if it does 
not meet these requirements.

Minimum system Recommended 
system

i486/25 MHz for Windows 95 and NT 4.0
i486/66 MHz for Windows 98
Pentium 133 MHz for Windows 2000
Pentium 150 MHz for Windows Me

Pentium II 300 MHz or 
higher processor

16 MB RAM for Windows 95/98, NT 4.0
64 MB RAM for Windows 2000
32 MB RAM for Windows Me

128 MB RAM or more

20 MB hard disk space for Windows 95 /98/Me
40 MB for Windows NT 4.0 and Windows 2000

400 MB or more free 
disk space

VGA monitor VGA or better monitor 
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For using your printer with a Macintosh
To use this printer, your Apple® Macintosh® must meet the 
following system requirements. You also need a USB cable to 
connect this printer to Apple Macintosh computers.

Note:
❏ The amount of available memory varies according to the number and 

kind of applications that are open. To see how much memory is 
available, choose About This Macintosh from the Apple menu and 
refer to the memory size (listed in kilobytes) under “Largest Unused 
Block” (1,024 K = 1 MB).

❏ The memory requirements above are for printing on A1 (594 × 
841 mm) size paper. These requirements may vary depending on the 
size of the paper, the type of application you are using, and the 
complexity of the document you want to print.

In addition to these system and memory requirements, you also 
need 12 MB of free hard disk space to install your printer software. 
To print, you need extra hard disk space amounting to about 
double the size of the files you want to print.

Minimum system Recommended system

PowerPC PowerPC 604e 300 MHz or higher 
processor

System 7.6.1 System 7.6.1 or later

9 MB of available memory
12 MB of available memory when 
background printing is turned on.

16 MB or more of available 
memory
27 MB of available memory when 
background printing is turned on.
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For using the Online Guide with a PC

For using the Online Guide with a Macintosh

System Microsoft Windows 95, 98, Me, NT 4.0 or 
Windows 2000

CPU Pentium 150 MHz processor for 
Windows Me 
Pentium for Windows 95, 98, and NT 4.0)
Pentium 133 MHz for Windows 2000

Memory 16 MB RAM for for Windows 95, 98, and 
NT 4.0
(32 MB or more recommended)
32 MB RAM for Windows Me and 2000

Hard disk space 4 MB to install the Reference Guide

CD-ROM drive Double-speed
(Quad-speed or better recommended)

Display 640 × 480 pixel or 800 × 600 pixel resolution, 
with High Color (16 bit) or True Color 
(32 bit) setting

Browser Web browser
(Microsoft Internet Explorer 4.0 or later 
recommended)

System System 7.5.1 (System 7.6 or later 
recommended)

Memory 16 MB (32 MB or more recommended)

Hard disk space 3 MB free to install the Reference Guide

CD-ROM drive Double-speed
(Quad-speed or better recommended)

Display Color monitor with 640 × 480 pixel 
resolution or greater
(Thousands of colors recommended)

Browser Web browser
Microsoft Internet Explorer 4.0 or later 
recommended)
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Safety Instructions

Important Safety Instructions

Read all of these instructions before using your printer. Also be 
sure to follow all warnings and instructions marked on the 
printer.

❏ Do not block or cover the openings in the printer’s cabinet.

❏ Do not insert objects through the slots. Take care not to spill 
liquid on the printer.

❏ Use only the type of power source indicated on the printer’s 
label.

❏ Connect all equipment to properly grounded power outlets. 
Avoid using outlets on the same circuit as photocopiers or air 
control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or 
automatic timers.

❏ Keep the entire computer system away from potential sources 
of electromagnetic interference, such as loudspeakers or the 
base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure the 
total ampere rating of the devices plugged into the extension 
cord does not exceed the cord’s ampere rating. Also, make 
sure the total ampere rating of all devices plugged into the 
wall outlet does not exceed the wall outlet’s ampere rating.

❏ Do not attempt to service the printer yourself.
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❏ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the 
printer; the printer has been dropped or the cabinet damaged; 
the printer does not operate normally or exhibits a distinct 
change in performance.

❏ If you plan to use the printer in Germany, observe the 
following:

To provide adequate short-circuit protection and over-
current protection for this printer, the building installation 
must be protected by a 10 or 16 amp circuit breaker.

Bei Anschluss des Druckers an die Stromversorgung muss 
sichergestellt werden, dass die Gebäudeinstallation mit einer 
10 A-oder 16 A-Sicherung abgesichert ist.
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A Few Precautions

When using the printer
❏ Do not put your hand inside the printer or touch the ink 

cartridges during printing.

❏ Do not move the print heads by hand; otherwise you may 
damage the printer.

❏ Always turn the printer off using the Power button on the 
control panel. When this button is pressed, the Operate light 
flashes briefly then goes off. Do not unplug the printer or turn 
off the power to the outlet until the Operate light stops 
flashing.

❏ Before transporting the printer, make sure the print heads are 
in the home (far right) position, and the ink cartridges are 
removed.

When handling the ink cartridges
❏ Keep ink cartridges out of the reach of children and do not 

drink.

❏ If ink gets on your skin, wash it off with soap and water. If it 
gets in your eyes, flush them immediately with water.
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❏ For best results, shake the ink cartridge gently before 
installing it.

c Caution
Do not shake cartridges that have been installed previously.

❏ Once you install an ink cartridge, do not remove the cartridge 
except to replace it with a new one. The printer may not 
determine the correct level of ink remaining.

❏ Do not use an ink cartridge beyond the date printed on the 
cartridge carton.

❏ For best results, use up the ink cartridges within six months 
of installation.

❏ Do not dismantle the ink cartridges or try to refill them. This 
could damage the print heads.
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When choosing a place for the printer
❏ Place the printer on a flat, stable surface that is larger than the 

printer. The printer will not operate properly if it is tilted or 
at an angle.

❏ Avoid places subject to rapid changes in temperature and 
humidity. Also keep it away from direct sunlight, strong light, 
or heat sources.

❏ Avoid places subject to shocks and vibrations.

❏ Keep the printer away from dusty areas.

❏ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Note for French-speaking users:
Placez l’imprimante près d’une prise de contacte où la fiche peut être 
débranchée facilement.

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined 
that this product meets the ENERGY STAR guidelines 
for energy efficiency.

The International ENERGY STAR Office Equipment Program is 
a voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient personal 
computers, monitors, printers, fax machines, and copiers in an 
effort to reduce air pollution caused by power generation.
Safety Instructions       5



  
For United Kingdom Users

Use of options

EPSON (UK) Limited shall not be liable against any damages or 
problems arising from the use of any options or consumable 
products other than those designated as Original EPSON 
Products or EPSON Approved Products by EPSON (UK) Limited.

Safety information

w Warning:
This appliance must be earthed. Refer to rating plate for voltage 
and check that the appliance voltage corresponds to the supply 
voltage.

Important:
The wires in the mains lead fitted to this appliance are coloured in 
accordance with the following code:

Green and yellow — Earth
Blue — Neutral
Brown — Live

If you have to fit a plug:
As the colours of the mains lead of this appliance may not match 
coloured markings used to identify the terminals in a plug, please 
proceed as follows:

The green and yellow wire must be connected to the terminal in 
the plug which is marked with the letter E or the earth symbol (G).

The blue wire must be connected to the terminal in the plug 
marked with the letter N.
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The brown wire must be connected to the terminal in the plug 
marked with the letter L.

If damage occurs to the plug, replace the cord set or consult a 
qualified electrician.

Replace fuses only with a fuse of the correct size and rating.

Warnings, Cautions, and Notes

w Warnings must be followed carefully to avoid bodily injury.

c Cautions
 must be observed to avoid damage to your equipment.

Notes contain important information and useful tips on the operation 
of your printer.
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Taking a Look at Your Printer

Front view

Rear view

mounting brackets roll paper cover

paper insertion slot

paper set lever

control panel

ink cartridge 
compartment

lower cover

paper guides

guide track

optional interface card slot cover

parallel interface connector

USB interface connector

AC inlet
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Connecting the Printer

The method you use to connect the printer to your computer 
depends on whether you want to send print jobs directly to the 
printer using the printer’s built-in parallel interface or a USB 
connection, or send print jobs to the printer over a network using 
an optional interface card. To connect the printer using the built-
in parallel interface, see the next section. To connect the printer 
using a USB connection, see “Using a USB connection (For 
Windows 98, Me, and 2000 only)” on page 1-3. For information 
on using optional interface cards, see “Using an optional interface 
card” on page 1-5.

Using the built-in parallel interface for PCs

To use the printer’s built-in parallel interface, you will need a 
shielded, twisted-pair cable. Follow the steps below to connect 
the printer to your computer.

Note:
Before you connect the parallel interface cable, disconnect the USB cable 
from the printer, if installed.

1. Make sure both the printer and computer are turned off.
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2. Plug the cable connector securely into the printer’s interface. 

Then squeeze the wire clips together until they lock into place 
on both sides. If your cable has a ground wire, connect it to 
the ground connector beside the interface connector.

 

3. Plug the other end of the cable into the computer’s parallel 
port. If there is a ground wire at the computer end of the cable, 
connect it to the ground connector at the back of the computer.

Now see “Installing the Printer Software” on page 1-8. You must 
install the printer software before using your printer.

Using a USB connection (For Windows 98, Me, 
and 2000 only)

To connect the printer to a USB port, you need a standard shielded 
USB cable. Follow the steps below to connect the printer to your 
computer.
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Note:
❏ The EPSON Printer Port and DMA transfer features (For 

Windows 95 and 98 only) of the EPSON printer driver you installed 
are not available with USB connection. They are available only with 
the parallel interface connection. For information on the EPSON 
Printer Port and DMA transfer, see the Online Guide.

❏ You need to select COMPAT in the PARA. I/F setting of SelecType 
mode. For details, see “SelecType Settings” in the Online Guide.

1. Make sure both the printer and computer are turned off.

2. Plug the appropriate end of the cable into the USB port on the 
back of the printer. (The end that fits the printer has a different 
shape from the end that fits the computer.)

3. Connect the other end of the cable to the computer’s USB port.

Now see “Installing the Printer Software” on page 1-8. You must 
install the printer software before using your printer.
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Using an optional interface card

Available optional interface cards
The optional Ethernet Interface Cards listed below let you use 
your printer on a network. The Ethernet card automatically 
detects the protocols on your network, so you can print from 
Windows 95, 98, Me, NT 4.0, and Windows 2000; and Macintosh 
on an AppleTalk network.

Note:
The asterisk in the product number is a substitute for the last digit, which 
varies by country.

Installing the optional interface card
To install an optional interface card, follow these steps:

Note:
Before you install the optional interface card, see the documentation that 
comes with the card for setup information.

1. Make sure the printer is turned off.

2. Make sure that the power cord is unplugged from the 
electrical outlet.

w Warning:
Do not install the interface card when the printer is 
connected to an electrical outlet. Doing so may damage the 
printer.

3. Disconnect the interface cable, if necessary.

Type B Ethernet Interface Card (10BASE-T)
Type B Ethernet Interface Card (100BASE-TX)
IEEE 1394 Interface Card

C82362✽

C82363✽
C82372✽
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4. Use a cross-head screwdriver to remove the two screws 
securing the shield plate to the optional interface slot, and lift 
off the plate. Be sure to keep the screws to use when you
re-install the shield plate.

5. Set the DIP switches and jumpers on the card, if necessary. 
See the interface card’s documentation for details.

6. Slide the interface card along the slots on both sides of the 
interface compartment. Push it in firmly to fully insert the 
connector at the rear of the interface card into the printer’s 
internal socket.

7. Secure the interface card in the slot with the two screws 
included with the interface card.
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8. Connect a compatible interface cable to the interface card and 

to your computer. If the cable has a ground wire, secure it with 
one of the screws.

Also, if you are using more than one computer, reconnect the 
other interface cable.

9. Make sure the printer is turned off. Then plug in the power 
cord.

Now see “Installing the Printer Software” on page 1-8 and 
“Setting up Your Printer on a Network” on page 1-14.

To remove an interface card, follow the above steps in reverse 
order.
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Installing the Printer Software

After connecting the printer to your computer, you need to install 
the software included on the “Printer Software for 
EPSON STYLUS PRO 7500” CD-ROM shipped with your printer.

Your printer software includes:

❏ Printer driver and utilities
The printer driver runs, or “drives,” your printer; use it to 
make settings such as print quality, speed, media type, and 
paper size. The Nozzle Check, Head Cleaning, and Print Head 
Alignment utilities help you keep your printer in top 
operating condition. EPSON Status Monitor 3 (for Windows) 
or EPSON StatusMonitor (for Macintosh) notifies you of 
printer errors and displays printer status information such as 
the amount of ink remaining.

❏ Printer Status Page utility (for Windows 2000 only)
The Printer Status Page utility (for Windows 2000 only) 
enables you to monitor the printer status and network settings 
over the Internet when using the Windows 2000 Internet 
Printing feature. To use this utility, you must obtain an 
optional network interface. See your network manual for 
more information.

❏ Online guide
The online Reference Guide helps you learn more about your 
printer.

If you are using the floppy disk version of the software, make a 
backup copy of the EPSON printer software disk before you begin 
installation. If you wish to make a floppy disk version of the 
printer software on your CD-ROM, you can use the driver disk 
creation utility included on the CD-ROM.
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For Windows

Follow these steps to install your printer software.

1. Make sure that your printer is off.

2. Turn on your computer and start Windows. If the New 
Hardware Found screen or any other Wizard appears, click 
Cancel.

3. Insert the printer software CD-ROM shipped with your 
printer in the CD-ROM drive. The Installer dialog box 
appears. (For floppy disk users, insert the disk in the disk 
drive and double-click the My Computer icon, then the 
floppy disk drive icon, and then Setup.exe.)

4. Click Install Printer Driver/Utility, then the right arrow, and 
then OK in the dialog box that appears to start the printer 
software installation.
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5. Windows 95 and NT users should proceed to step 6.

For Windows 98 users, follow the on-screen instructions to 
turn on your printer. The printer port configuration starts 
automatically.

For printers connected via USB cable, the USB device driver 
installation starts automatically at this point.

6. When a message appears informing you that installation is 
complete, click OK.

Note:
If an error message appears, either the printer driver or the EPSON 
USB printer device driver is not installed correctly. See 
“Troubleshooting” in the Online Guide.

For information on opening and using the printer software, see 
“Printing from Your PC” on page 2-14. If you use your printer on 
a network, see “Setting up Your Printer on a Network” on page 
1-14.

Ensuring that the USB driver is installed correctly in Windows 
(for Windows 98 and Me only)

After the printer software installation is complete, confirm that 
the USB driver is installed correctly.

1. Click the Start button, point to Settings, and click Printers. 
Make sure that the icon for your printer appears in the Printers 
window.
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2. Click the icon for your printer, then click Properties on the 

File menu.

3. Click the Details tab and make sure that EPUSBx: (EPSON 
Stylus Pro 7500) is displayed in the Print to the following port 
list box.

Note:
If the correct port is not displayed, refer to the “Troubleshooting” 
section of the Online Guide.
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For Macintosh

c Caution:
Turn off all virus protection programs before you install your 
printer software.

Follow these steps to install your printer software.

1. Turn on your Macintosh and insert the software CD-ROM 
shipped with your printer in the CD-ROM drive. The EPSON 
printer software disk opens automatically.

2. If a single Installer icon appears, double-click the icon. If 
separate folders containing installer icons for several 
languages appear, double-click the folder for your preferred 
language, then double-click the Installer icon inside it.

3. At the initial screen, click Continue. The following dialog box 
appears.

4. To install the printer software included on your printer 
software CD-ROM, make sure the Install Location box 
displays the correct disk drive, then click Install.

5. When a message appears informing you that the installation 
is complete, click Restart to restart your computer.
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Selecting your printer in the Chooser for Macintosh

After you have installed the printer software on your Macintosh, 
you need to open the Chooser and select your printer. You must 
select a printer the first time you use it or whenever you want to 
switch to another printer. Your Macintosh will always print using 
the last printer selected.

1. Select Chooser from the Apple menu. Then click your 
printer's icon and the port your printer is connected to.

2. Select the appropriate Background Printing radio button to 
turn background printing on or off.

With background printing on, you can use your Macintosh 
while it is preparing a document for printing. In order to use 
the EPSON Monitor3 utility to manage print jobs, background 
printing must be turned on.

3. Close the Chooser.

For information on opening and using the printer software, see 
“Printing from Your Macintosh” on page 2-20. If you use your 
printer on a network, see “Setting up Your Printer on a Network” 
on page 1-14.
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Setting up Your Printer on a Network

For Windows 95, 98, and Me

This section tells you how to set up your printer so that other 
computers on the network can use it.

First, you need to set up the printer as a shared printer on the 
computer to which it is connected. Then, you must specify the 
network path to the printer from each computer that will use it, 
and install the printer software on those computers.

Note:
This section describes how to use your printer as a shared printer on a 
network. To connect your printer directly to a network without setting 
it up as a shared printer, consult your network administrator.

Setting up your printer as a shared printer
Follow these steps to share a printer connected directly to your 
computer with other computers on a network.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click Network.

3. Click the File and Print Sharing button.
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4. Select the I want to be able to allow others to print to my 

printer(s) check box and click OK.

5. In the Network window, click OK.

6. In the Control Panel, double-click Printers.

Note:
❏ If a dialog box requesting the Windows 95 or 98 CD-ROM 

appears, insert the CD-ROM in the CD-ROM drive, then 
follow the messages on the screen.

❏ If a dialog box appears requesting you to restart your computer, 
do so. Then open the Printers folder, and continue from step 7.

7. Select your printer, and choose Sharing on the File menu.
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8. Select Shared As, enter the printer information as needed, 
then click OK.

Accessing the printer through a network
To access your printer from another computer on the network, 
follow these steps.

Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer. For instructions, see “Setting up your printer as a shared 
printer” on page 1-14.

1. On the computer from which you want to access the printer, 
click Start, point to Settings, and click Printers.

2. Double-click the Add Printer icon.
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3. The Add Printer Wizard screen appears. Click Next.

4. Click Network printer, then click Next.

5. Click Browse.

6. Double-click the icon of the computer that is directly 
connected to the printer. Then click the printer’s icon.

7. Click OK and follow the messages on the screen.
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For Windows NT 4.0 and Windows 2000

Note:
This section is written for small network users only. If you are on a large 
network and would like to share your printer, consult your network 
administrator.

This section tells you how to set up your printer so that other 
computers on the network can use it.

First, you need to set up the printer as a shared printer on the 
computer to which it is connected. Then, you must specify the 
network path to the printer from each computer that will use it, 
and install the printer software on those computers.

Setting up your printer as a shared printer
Follow these steps to share a printer that is connected directly to 
your computer with others on a network.

1. Click Start, point to Settings, and click Printers.

2. Select your printer, then click Sharing on the File menu.

3. Click Shared and enter the Share Name.
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4. Click OK.

Note:
Do not choose any drivers from the Alternate Drivers list.

Accessing the printer through a network
To access your printer from another computer on the network, 
follow these steps.

Note:
Your printer must be set up as a shared resource on the computer to 
which it is directly connected before you can access it from another 
computer. For instructions, see “Setting up your printer as a shared 
printer” on page 1-18.

1. Install the printer driver to the client computer from the 
software CD-ROM.

2. Open the Printer folder from the Control Panel, right-click 
your printer’s icon, then open the Properties for your printer.
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3. Click the Ports tab, then click Add Port.

4. The following dialog appears. Select Local Port, then click 
New Port.
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5. The following dialog appears. In the text box, type the 

following information:

\\name of computer that is connected to the printer\name of 
the shared printer

Then click OK.

6. In the Printer Ports dialog box, click Close to return to the 
Ports menu.
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7. On the Ports menu, make sure that the new port is added and 
the check box is selected. Click OK to close the printer driver.

For Macintosh

This section tells you how to set up the printer for use on an 
AppleTalk network. By setting up your local printer as a shared 
printer, it becomes connected to the network and can be used by 
other computers.

First, you need to setup the printer as a shared printer on the 
computer to which it is connected. Then, you must specify the 
network path to the printer from each computer that will use it, 
and install the printer software on those computers.

Setting up your printer as a shared printer
Follow these steps to share a printer connected directly to your 
computer with other computers on an AppleTalk network.

1. Turn on the printer.
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2. Select Chooser from the Apple menu and click the printer's 

icon. Then select the port to which the printer is connected.

3. Click the Setup button. The following dialog box appears.

4. Select the Share this Printer check box, then type the printer 
name and password information as needed.

5. Click OK. The name of the shared printer appears in the port 
list in the Chooser.

6. Close the Chooser.
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Accessing the printer through a network
To access your printer from another computer on the network, 
follow these steps.

1. Turn on your printer.

2. On each computer from which you want to access the printer, 
select Chooser from the Apple menu. Then click your 
printer’s icon and select the printer port you want to use from 
the Select a printer port box on the right. You can only select 
from the printers connected to your current AppleTalk zone.
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3. If the following dialog box appears, enter the password for 

the printer, then click OK.

4. Select the appropriate Background Printing option button to 
turn background printing on or off.

5. Close the Chooser.
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Loading Roll Paper

Attaching the roll paper to the printer

To attach the roll paper to the printer, follow the steps below.

1. Place the roll paper on a flat surface so that the paper unwinds 
in the direction as shown below.

2. Slide the roll paper onto the spindle until it fixes into place on 
the fixed flange.
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3. Slide the movable flange onto the spindle until it fixes into 

place in the end of the roll paper.

4. Open the roll paper cover.
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5. Hold the roll paper spindle so that the fixed flange is on the 
right side. Then place the spindle on the groove on top of the 
printer once.

Note:
To mount the spindle correctly, match the color of the end of the 
spindle with the mounting bracket.
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6. Lift the spindle again, then place it on the mounting brackets 

inside the printer.

7. Close the roll paper cover until it locks into place or see 
“Loading the roll paper” to load the paper.
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Loading the roll paper

To load roll paper, follow the steps below.

1. Make sure that the printer is on.

2. Press the Paper Source button repeatedly until the Roll Auto 
Cut light or Roll Cutter Off light comes on.

c Caution:
Depending on the kind of paper used, automatic cutting may 
not be possible.

3. Make sure the Operate light and Pause light are not flashing, 
then push the paper set lever all the way down.  LOAD PAPER 
appears on the LCD panel.

c Caution:
Do not move the paper set lever while the Operate light or 
Pause light is flashing. Doing so may damage the printer.
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4. Open the roll paper cover.

5. Load the paper into the paper insertion slot. 
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6. Pull the paper down a small way through the paper insertion 
slot.

Note:
If the bottom edge of the paper does not come out below the lower 
cover, open the lower cover by pulling down on the handles, then 
pull the paper through.

7. Holding the bottom edge of the paper, roll back the roll paper 
using the flange on the right to remove the slack. Make sure 
that the bottom edge of the paper is straight and in line with 
the rows of punch holes.
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8. Pull the paper set lever all the way up, then close the roll paper 

cover. PRESS PAUSE BUTTON appears on the LCD panel.

9. Press the Pause button.

The print heads move and the paper automatically feeds into 
the printing position. READY appears on the LCD panel.

Note:
Even if you do not press the Pause button, the print heads move, 
the paper automatically feeds into the printing position. READY 
appears on the LCD panel.

10. Extend the two paper guides out from the lower printer.
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Now you are ready to print on the roll paper. Make the printer 
driver settings, then send a print job. See “Printing from Your PC” 
on page 2-14 or “Printing from Your Macintosh” on page 2-20.

Loading Cut Sheet Media

To load a cut sheet longer than 483 mm (long edge of Super A3/B 
size), see the next section. To load paper with a length of 483 mm 
or shorter, see “Loading cut sheet with a length of 483 mm (long 
edge of Super A3/B) or shorter” on page 2-13.

If you are printing on thick paper (0.5 to 1.5 mm), see the Online 
Guide.

Loading cut sheet media longer than 483 mm 
(long edge of Super A3/B size)

To load cut sheet media longer than 483 mm, follow the steps 
below.

c Caution:
As much as possible, keep your fingers off the printable surface 
of the media, as fingerprints may reduce printout quality.

1. Make sure that the printer is on and the roll paper cover is 
closed.

2. Press the Paper Source button repeatedly until the Sheet 
light comes on.
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3. Make sure the Operate light and Pause light are not flashing, 
then push the paper set lever all the way down. LOAD PAPER 
appears on the LCD panel.

c Caution:
Do not move the paper set lever while the Operate light or 
Pause light is flashing. Doing so may damage the printer.

4. Load the sheet into the paper insertion slot until it comes out 
below. Make sure that the right and bottom edges of the sheet 
are straight and in line with the rows of punch holes.
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5. Pull the paper set lever all the way up. PRESS PAUSE BUTTON 
appears on the LCD panel.

 

6. Press the Pause button.

The print heads move and the sheet automatically feeds into 
the printing position. READY appears on the LCD panel.

Note:
Even if you do not press the Pause button, the print heads move, 
the paper automatically feeds into the printing position. READY 
appears on the LCD panel.

Now you are ready to print on the cut sheet media. Make the 
printer driver settings, then send a print job. See “Printing 
from Your PC” on page 2-14 or “Printing from Your 
Macintosh” on page 2-20.
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Loading cut sheet with a length of 483 mm (long 
edge of Super A3/B) or shorter

To load cut sheet media with a length of 483 mm or shorter, follow 
the steps below.

c Caution:
As much as possible, keep your fingers off the printable surface 
of the media, as fingerprints may reduce printout quality.

1. Make sure that the printer is on and the roll paper cover is 
closed.

2. Press the Paper Source button repeatedly until the Sheet 
light comes on.

3. Make sure that the paper set lever is all the way up. Then load 
the sheet into the paper insertion slot until it meets resistance. 
Make sure that the right edge of the paper is straight and in 
line with the right edge of the scale on the roll paper cover. 
PRESS PAUSE BUTTON appears on the LCD panel.
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4. Press the Pause button.
The print heads move and the sheet automatically feeds into 
the printing position. READY appears on the LCD panel.

Now you are ready to print on the cut sheet media. Make the 
printer driver settings, then send a print job. See “Printing 
from Your PC” on page 2-14 or “Printing from Your 
Macintosh” on page 2-20.

When printing is complete, the printer supports the printed 
media, and PAPER OUT is displayed on the LCD panel. To 
remove the paper, hold it while pressing the Paper Feed 
button. The paper can be removed from the printer.

Printing from Your PC

After loading the paper, you are ready to print your document 
from your PC.

Note:
To ensure print quality, you may need to check the printer’s condition 
before printing. See Chapter 3, “Checking the Printer’s Condition.”

Making the printer driver settings

To make the basic settings to print your documents, access the 
Main menu and Paper menu in the printer driver. In the Paper 
menu, you can set particular settings for printing on roll paper; 
Auto Rotate, Auto Cut, Print Page Line, and Save Roll Paper.

For details about the printer software, see online help by pressing 
the Help button in the driver settings window.

1. Click Print on the File menu. The Print dialog box appears.
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2. Make sure your printer is selected and then click Properties, 

or Options. You may need to click a combination of these 
buttons. The driver settings window appears.

3. Click the Main tab to display the Main menu.

 

4. Select the media you loaded in the printer from the Media 
Type list.

Note:
The Media Type setting determines what other settings are 
available, so you should always make this setting first.

5. In the Ink box, select Color to print in color, or Black to print 
in black and white.
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6. Make sure the Automatic radio button in the Mode box is 
selected.

Note:
When Automatic is selected, the printer driver takes control of all 
detailed settings based on the current Media Type setting and Ink 
setting.

7. Adjust Speed and Quality in the Mode box if a slider appears. 
Drag the slider left or right depending on which is more 
important. This setting is usually automatically decided in 
accordance with your Media Type setting.

Note:
Depending on the media selected in the Media Type list (while 
Automatic is selected), a slider appears under the Custom radio 
button that lets you choose from Quality or Speed settings. Select 
Quality when print quality is more important than speed.

8. Click the Paper tab to display the Paper menu.
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9. Select the type of paper you loaded in the printer from the 

Paper Source list.

10. Select the paper size you loaded in the printer from the Paper 
Size list/Page Size list (available only for Roll Paper (Banner)).

Note:
Most Windows applications feature paper size and page size settings 
that override similar settings in the printer driver.

11. If you are using the roll paper, set the Roll Paper Option as 
required.

Auto Rotate (unavailable for Roll Paper (Banner))
If the length of your document is shorter than the printable 
width of the roll paper, the document will automatically be 
turned by 90 degrees and printed crosswise when you select 
Auto Rotate. You can save paper by using this function.

Auto Cut
Roll paper will automatically be cut after printing one page 
when you select Auto Cut.

Print Page Line
Page lines will be printed on the right side and below the 
document for manual cutting when you select Print Page 
Line.

Save Roll Paper (available only for Roll Paper (Banner))
Select this check box when you wish to save roll paper. The 
blank portion of the last page of your document is not fed 
through the printer.

12. Make settings for Orientation, Copies, and Printable Area. 
(The Printable Area setting is available only when Sheet is 
selected in the Paper Source list.)
Printing and Printer Management      2-17



13. Click the Layout tab to display the Layout menu.

14. Make sure the Normal radio button in the Reduce/Enlarge 
box is selected.

15. Click the OK button at the bottom of the window. The screen 
returns to the Print dialog box (or a similar dialog box).

16. Click Close, OK, or Print to print. You may need to click a 
combination of these buttons.
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While printing, the EPSON Progress Meter will appear, showing 
the progress of printing and the status of your printer.

 

For details, see “Printer Software” in the Online Guide.

Cancelling printing from your PC

To cancel the printing in progress, press the Stop button on the 
EPSON Progress Meter.

You can also pause or restart printing. To pause printing, press 
the Pause button. To resume printing, press this button again.

c Caution:
When you stop printing in progress, you may need to start 
printing again from the beginning for best result. Otherwise 
misalignment or banding may appear on the printed image.
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Printing from Your Macintosh

After loading the paper, you are ready to print your document 
from your Macintosh.

Note:
To ensure print quality, you may need to check the printer’s condition 
before printing. See Chapter 3, “Checking the Printer’s Condition.”

Making the printer driver settings

To make the printer driver settings, follow the steps below.

For details about the printer software, see online help by pressing 
the Help icon button (marked with “?”) in the driver setting dialog 
boxes.

Note:
While many Macintosh applications override the settings made in the 
printer driver, some do not, so you must verify the settings to get the 
results you expect.

1. Choose Page Setup from the File menu. This brings up the 
Page Setup dialog box shown below.

 

2. Select the paper size you loaded in the printer from the Paper 
Size list.
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3. Select the type of paper you loaded in the printer from the 

Paper Source list.

4. If you are using roll paper, set the Roll Paper Option as 
required.

Auto Rotate (unavailable for Roll Paper (Banner))
If the length of your document is shorter than the printable 
width of the roll paper, the document will automatically be 
turned by 90 degrees and printed crosswise when you select 
Auto Rotate. You can save paper by using this function.

Auto Cut
Roll paper will automatically be cut after a document is 
printed when you select Auto Cut.

Print Page Line
Page lines will be printed on the right side and below the 
document for manual cutting when you select Print Page 
Line.

Save Roll Paper (available only for Roll Paper (Banner))
Select this check box when you wish to save roll paper. The 
blank portion of the last page of your document is not fed 
through the printer.

5. Make settings for Orientation, Reduce or Enlarge, and 
Printable Area. (The Printable Area setting is available only 
for Sheet.)

6. After making your settings, click the OK button to close the 
Page Setup dialog box.

Note:
You cannot print from the Page Setup dialog box. You can only print 
from the Print dialog box.
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7. Choose Print from the File menu. The Print dialog box appears 
as shown below.

Note:
You can also open the Print dialog box by pressing the Options 
button in the Page Setup dialog box.

 

8. Select the media you loaded in the printer from the Media 
Type list.

Note:
The Media Type setting determines what other settings are 
available, so you should always make this setting first.

9. In the Ink box, select Color to print in color, or Black to print 
in black and white.

10. Make sure the Mode option is set to Automatic.

Note:
When Automatic is selected, the printer driver takes control of all 
detailed settings based on the current Media Type setting and Ink 
settings.
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11. Adjust Speed and Quality in the Mode box if a slider appears. 
Drag the slider left or right depending on which is more 
important. This setting is usually automatically decided in 
accordance with your Media Type setting.

Note:
Depending on the media selected in the Media Type list (while 
Automatic is selected), a slider appears on the right of the Mode box 
that lets you choose from Quality or Speed settings. Select Quality 
when print quality is more important than speed.

12. Be sure to make the settings for Copies and Pages, then click 
the Print button to start printing.

Cancelling printing from your Macintosh

To cancel the printing in progress, follow the instructions below.

c Caution:
When you stop printing in progress, you may need to start 
printing again from the beginning for best result. Otherwise 
misalignment or banding may appear on the printed image.

When background printing is on
1. Press the Power button to turn off the printer.

2. Select EPSON Monitor3 from the application menu.
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3. Click the name of the document which is printing in the 
Document Name list, then click the  stop button to cancel 
the print job.

When background printing is off
1. Press the Power button to turn off the printer.

2. Hold down the J key while pressing the period key [.] to 
cancel the print job.
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Using Printer Utilities

To ensure print quality, you may need to check the printer’s 
condition using the following utilities from the printer software.

Note:
You can also check from the printer’s control panel. See “The Control 
Panel” in the Online Guide.

❏ Nozzle Check

❏ Print Head Cleaning

❏ Print Head Alignment

Accessing the printer utilities

To access the printer utilities, follow the steps below.

For Windows
1. Double-click the My Computer icon, then double-click the 

Printers folder.

2. For Windows 95, 98 and Me, right-click your Printer icon, then 
click Properties. For Windows NT 4.0, right-click your 
Printer icon, then click Document Defaults. For Windows 
2000, right-click your printer icon, then click Printing 
Preferences. The printer software window appears. Then 
click the Utility tab.

For Macintosh
From the File menu of your application, choose Print or Page 
Setup to access the Print dialog box or Page Setup dialog box. 
Then click the  utility icon.
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Printing the Nozzle Check Pattern

You can check the print head nozzles from your computer with 
the Nozzle Check utility in the printer software.

Note:
Do not start the Nozzle Check utility while printing is in progress. 
Doing so may smudge your printout.

Follow the steps below:

1. Make sure the printer is turned on and paper is loaded in the 
printer. (A4 or wider paper)

2. Access the printer software. See “Accessing the printer 
utilities” on page 3-2.

3. Click the Nozzle Check button.

4. Follow the messages on your screen.

The printer prints an operational check page including firmware 
(ROM) version information and a nozzle check pattern. The 
nozzle check pattern will resemble one of the two samples shown 
below:

Nozzle Check Pattern

Good Condition: Print heads do not require cleaning.

Poor Condition: Segments are missing. Print heads require cleaning.
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Note:
Actual tests are printed in color.

Missing segments in printed lines in your nozzle check indicate 
that the ink nozzles are clogged and the print heads require 
cleaning.

c Caution:
Make sure that the nozzle check pattern printing is complete 
before you start printing. Otherwise, print quality may suffer.

Cleaning the Print Heads

You can clean the heads from your computer using the Head 
Cleaning utility in the printer software, as explained in the 
following steps.

Note:
❏ Print head cleaning uses ink. To avoid wasting ink, clean the print 

heads only if print quality declines.

❏ Use the Nozzle Check utility to confirm that the print heads need to 
be cleaned, as this uses only a little ink.

❏ When an Ink Out light on the printer is flashing (ink low) or on (ink 
out), you cannot clean the print heads before replacing the 
appropriate ink cartridge first.

❏ Do not start the Head Cleaning or Nozzle Check utilities while 
printing is in progress. Doing so may smudge your printout.
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Follow the steps below:

1. Make sure the lights on the control panel do not indicate that 
ink is low or ink is out.

2. Access the printer software. See “Accessing the printer 
utilities” on page 3-2.

3. Click the Head Cleaning button.

4. Follow the messages on your screen.

The Pause light on the printer flashes during the cleaning 
cycle, which takes about one minute to complete.

c Caution:
Never turn off the printer until the cleaning cycle is finished 
and the Pause light has stopped flashing. Doing so may 
damage the printer.

5. When the Pause light is off, click Print nozzle check pattern 
(Windows) or the Confirmation button (Macintosh) in the 
Head Cleaning dialog box, or print a few lines from a 
document, to confirm that the heads are clean.

Nozzle Check Pattern

Good Condition: Print head cleaning was successful.

Poor Condition: Segments are missing. Print heads require further 
cleaning.
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Note:
Actual tests are printed in color.

In the check pattern, if you find that segments are still missing 
from the test lines, you may need to repeat the head cleaning 
function and print the nozzle check pattern again.

If print quality does not improve even after repeating this 
procedure several times, turn the printer off and leave it alone 
overnight. Then, clean the head again.

If print quality remains a problem after replacing the ink 
cartridges, contact your dealer.

Aligning the Print Heads

You can align the print heads using the Print Head Alignment 
utility in the printer software.

Note:
❏ Do not start the Print Head Alignment utility while printing is in 

progress. Doing so may smudge your printout.

❏ Alignment pattern printing requires 1.5 m roll paper.

Follow the steps below:

1. Make sure the printer is turned on, and the EPSON special 
roll paper you plan to use is loaded in the printer. (24 inch roll 
paper is recommended.)

Note:
If you plan to use paper other than EPSON special paper, you may 
need to align the print heads using the SelecType settings. See 
“SelecType Settings” in the Online Guide.
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2. Access the printer software. See “Accessing the printer 

utilities” on page 3-2.

3. Click the Print Head Alignment button.

4. Follow the messages on your screen. The printer prints the 
head alignment patterns.

5. Choose the set number that has the smallest gaps in each 
alignment pattern. In the example below, the marked set 
numbers have the smallest gaps.

s
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6. Select the number you chose in step 5 (for example, number 
4), then click Finish.

Note:
If the set with the smallest gaps is unclear and cannot be selected, 
click the Realignment button and repeat from step 5.
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